
Q .1Q .1 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   �र पो ट��र पो ट�   नेने  2 0 24   2 0 24  म�म�   मलया लममलया लम   िफ�िफ�   उ !ो गउ !ो ग   म�म�   म#हला ओंम#हला ओं   केके   शो ष णशो ष ण   औ रऔ र   यौ नयौ न
उ ,ी ड़ नउ ,ी ड़ न   प रप र   / का श/ का श   डा लाडा ला ,  ,  औ रऔ र   का य�2 लका य�2 ल   प रप र   उ ,ी ड़ नउ ,ी ड़ न   केके   3ा प क3ा प क   मु5ेमु5े   क6क6   ओ रओ र   7ा न7ा न   आ क िष �तआ क िष �त   िक यािक या ??

A nsA ns 1. =ायमू�त� ?ीकृA स�म�त क6 �रपोट�
2 . =ायमू�त� बी .एन. ?ीकृA क6 म72ता �रपोट�
3. =ायमू�त� वमF स�म�त क6 �रपोट�
4. =ायमू�त� हेमा स�म�त क6 �रपोट�

Q .2Q .2 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न   सै=सै=   �वजय�वजय   केके   संद भ�संद भ�   म�म�   सबसेसबसे   / �सK/ �सK   चा लुMचा लुM   शा सकशा सक   थाथा ??
A nsA ns 1. पुलके�शन #Oतीय

2. �वPमा#दQ #Oतीय
3. पुलके�शन /थम
4. क6�त�वम�न #Oतीय

Q .3Q .3 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सीसी   घ ट नाघ ट ना   सबसेसबसे   प हलेप हले   घ िट तघ िट त   हुईहुई   थीथी ??
A nsA ns 1. पहला आंU-मराठा युK

2. बWर का युK
3. Xासी का युK
4. पानीपत का तीसरा युK

Q .4Q .4 भा र ती यभा र ती य   सं�वधा नसं�वधा न   केके   िक सिक स   संशो धनसंशो धन   Oा राOा रा   उ 5े �शकाउ 5े �शका   म�म�  ' ' समा जवा दीसमा जवा दी  ( S oc ia l is t) '   ( S oc ia l is t) '  शdशd   जो ड़ाजो ड़ा   ग याग या ??
A nsA ns 1. 42वe संशोधन

2. 44वe संशोधन
3. 86वe संशोधन
4. 25वe संशोधन
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Q . 5Q . 5 कु तुबु5ी नकु तुबु5ी न   ऐबकऐबक   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   रा जारा जा   काका   त ुकjतुकj   ग ुला मगुला म   थाथा ??
A nsA ns 1. महमूद गजनी

2. शkु5ीन इmुत�मश
3. मुहnद गोरo
4. गयासु5ीन बलबन

Q .6Q .6 सा #हQसा #हQ , ,  �वpा न�वpा न ,  ,  क लाक ला   औ रऔ र   सा मा �जकसा मा �जक   सेवासेवा   म�म�   उ qृ rताउ qृ rता   केके   आ धा रआ धा र   प रप र ,  ,  रा rs प �तरा rs प �त   Oा राOा रा  ______  ______ सद uvसद uv   कोको
रा wसभारा wसभा   म�म�   मनो नी तमनो नी त  ( nominate)   ( nominate)  िक यािक या   जा ताजा ता   हैहै ।।

A nsA ns 1. 8
2. 15
3. 10
4. 12

Q .7Q .7 िक सिक स   कं प नीकं प नी   नेने  A I - A I- संचा �लतसंचा �लत   गो }गो } -- मे~�ंगमे~�ंग  ATM   ATM  काका   अना वर णअना वर ण   िक यािक या   हैहै ,  ,  जोजो   उ प यो ग क तF ओंउ प यो ग क तF ओं   कोको   सो नासो ना
ख रo द नेख रo द ने ,  ,  बेचनेबेचने ,  ,  �व�नमय�व�नमय   क र नेक र ने ,  ,  प �ेप �े   प रप र   दे नेदे ने ,  ,  िड �जटा इज़िड �जटा इज़   क र नेक र ने   औ रऔ र   मु�ी क र णमु�ी क र ण   क र नेक र ने   म�म�   स�मस�म   बना क रबना क र   सो नेसो ने
केके   लेनदे नलेनदे न   म�म�   बद ला वबद ला व   क रे गाक रे गा ??

A nsA ns 1. मुथूट फाइन�स (Muthoot Finance)
2. गो}�स�ा (Goldsikka)
3. HDFC गो} (HDFC Gold)
4. टाटा गो} (Tata Gold)

Q .8Q .8 अंक समु�अंक समु�   प �ीप �ी   संर �णसंर �ण   �र जव��र जव�  ( A nkas amudra B ird  C ons ervat ion Res erve)   ( A nkas amudra B ird  C ons ervat ion Res erve)  भा र तभा र त   केके   िक सिक स   रा wरा w
म�म�   �2 त�2 त   हैहै ??

A nsA ns 1. म7 /देश
2. राज2ान
3. ओिडशा
4. कनFटक

Q .9Q .9 को ईको ई   3 ��3 ��   अप नेअप ने   घ रघ र   सेसे   �नक लने�नक लने   वा लेवा ले   क चरेक चरे   कोको   न#द यvन#द यv   औ रऔ र   झी लvझी लv   म�म�   फ� क क रफ� क क र   उ ��उ ��   / दू िष त/ दू िष त   क रक र   र हार हा   हैहै ।।
इसइस   संद भ�संद भ�   म�म� ,  ,  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   मौ �लकमौ �लक   क त�3क त�3   काका   उ �ंघ नउ �ंघ न   होहो   र हार हा   हैहै ??

A nsA ns 1. देश क6 समृK �वरासत का मह� समझना और उसका संर�ण करना
2. महान आदश� को संजोकर रखना और उनका पालन करना
3. 3��गत और सामू#हक ग�त�व�ध के सभी �े�v म� उqृrता के �लए /यास करना
4. /ाकृ�तक पयFवरण क6 र�ा और सुधार करना
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Q .1 0Q .1 0 / धा नमं�ी/ धा नमं�ी   नर� �नर� �   मो दीमो दी   नेने  1 2   1 2  मा च�मा च�  2 0 24   2 0 24  कोको   मॉ रo शसमॉ रo शस   म�म�   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   प �व�प �व�   2 ल2 ल   काका   दौ रादौ रा
िक यािक या   औ रऔ र   वहeवहe   प ूजाप ूजा -- अच�नाअच�ना   क6क6 ??

A nsA ns 1. बाटू गुफाएँ (Batu Caves)
2. क¢ डी मं#दर (Kandy Temple)
3. गंगा तालाब (Ganga Talao)
4. पशुप�तनाथ मं#दर (Pashupatinath Temple)

Q .1 1Q .1 1 2 0 1 1  2 0 1 1  क6क6   जनग णनाजनग णना   म�म�   भा र तभा र त   क6क6   ?मजी वी?मजी वी   जनसं¨ाजनसं¨ा   कोको   चा रचा र   / मुख/ मुख   ?े©णयv?े©णयv   म�म�   �वभा �जत�वभा �जत   िक यािक या   ग याग या ।।
इनम�इनम�   सेसे   एकएक   ?ेणी?ेणी   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सीसी   हैहै ??

A nsA ns 1. /वासी ?�मक

2. बेरोजगार जनसं¨ा
3. कृषक
4. �वदेश म� काय� करने वाले 3��

Q .1 2Q .1 2 उ ª रoउ ª रo   भा र तभा र त   म�म� ,  ,  मा नसूनमा नसून   म�म�   «का वट«का वट   अWरअWर   मा नसूनमा नसून   ग त�ग त�   याया  ITC Z  ITC Z केके   सा थसा थ   िक सक6िक सक6   क मीक मी   केके   का र णका र ण   हो तीहो ती
हैहै ??

A nsA ns 1. बादलv का बनना
2. तापमान म� बदलाव
3. बारंबार वषF-धारo तूफान
4. आपे��क आ��ता म� वृ©K

Q .1 3Q .1 3 लैटे रा इटलैटे रा इट   मृदामृदा   भा र तभा र त   म�म�   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   फसलफसल   समूहसमूह   केके   �लए�लए   उ प यु�उ प यु�   हैहै ??
A nsA ns 1. चावल और गेहंू

2 . ग­ा और दाल�
3. सरसv और चावल
4. चाय और काजू

Q .1 4Q .1 4 =ा यमू�त �=ा यमू�त �   महा दे वमहा दे व   गो �व ंदगो �व ंद   रा ना डेरा ना डे   नेने   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   संग ठनसंग ठन   क6क6   2ा प ना2ा प ना   म�म�   मह� पूण�मह� पूण�   भू�मकाभू�मका   �नभा ई�नभा ई
थीथी ??

A nsA ns 1. आय� समाज
2. ®¯ समाज
3. मोहnडन �लटरेरo सोसायटी
4. पूना साव�ज�नक सभा
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Q .1 5Q .1 5 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   संग ठनसंग ठन   नेने   लैिट नलैिट न   अमे�र काअमे�र का   औ रऔ र   कै �र �बयनकै �र �बयन   म�म�   मह� पूण�मह� पूण�   जलवा युजलवा यु   औ रऔ र   मौ सममौ सम   संबंधीसंबंधी
आंक ड़vआंक ड़v   केके   सं° हसं° ह   औ रऔ र   सा झा क र णसा झा क र ण   कोको   बढ़ा नेबढ़ा ने   केके   �लए�लए   इंट रइंट र -- अमे�र क नअमे�र क न   डे वलप म�टडे वलप म�ट   ब¢कब¢क  ( Inter- A meric an ( Inter- A meric an
Development Bank)  Development Bank)  केके   सा थसा थ   सा झेदा रoसा झेदा रo   क6क6 ??

A nsA ns 1. �व² ³ा´ संगठन
2. संयु� राrs  /�श�ण और अनुसंधान सं2ान
3. �व² ब¢क
4. संयु� राrs  �वकास काय�Pम

Q .1 6Q .1 6 भा र ती यभा र ती य   सं�वधा नसं�वधा न   क6क6  7 7 वµवµ   अनुसूचीअनुसूची   म�म�   कौ नकौ न -- सासा   अनु¶ेदअनु¶ेद   हैहै ??
A nsA ns 1. अनु¶ेद 244

2. अनु¶ेद 289
3. अनु¶ेद 259
4. अनु¶ेद 246

Q .1 7Q .1 7 रा rs ी यरा rs ी य   खेलvखेलv   काका  3 7 3 7 वeवe   सं·र णसं·र ण   क हeक हe   आ यो �जतआ यो �जत   िक यािक या   ग याग या ??
A nsA ns 1. गुजरात

2. राज2ान
3. गोवा
4. नई #द�ी

Q .1 8Q .1 8 अ¸ू बरअ¸ू बर  2 0 24   2 0 24  म�म� ,  ,  भा रoभा रo   बा �र शबा �र श   केके   का र णका र ण   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   रे लवेरे लवे   ¹ेशन¹ेशन   क6क6   नव�न�म�तनव�न�म�त   छतछत
��त ° »��त ° »   होहो   ग ईग ई ,  ,  �जससे�जससे   रे लरे ल   मं�ा लयमं�ा लय   औ रऔ र   महा रा rsमहा रा rs   सर का रसर का र   प रप र   सवा लसवा ल   उ ठेउ ठे ??

A nsA ns 1. नागपुर रेलवे ¹ेशन
2. र¼ा�गरo रेलवे ¹ेशन
3. क½ाण रेलवे ¹ेशन
4. मंुबई रेलवे ¹ेशन

Q .1 9Q .1 9 भा र तभा र त   क6क6  2 0 1 1   2 0 1 1  क6क6   जनग णनाजनग णना   केके   अनुसा रअनुसा र ,  ,  सबसेसबसे   क मक म   जनसं¨ाजनसं¨ा   घ न�घ न�   वा लावा ला   क� �क� �   शा �सतशा �सत   / दे श/ दे श
�न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा   हैहै ??

A nsA ns 1. ल5ाख
2. दादरा और नगर हवेली
3. दमन और दीव
4. अंडमान और �नकोबार
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Q .2 0Q .2 0 �सखv�सखv   कोको   आ धु�नकआ धु�नक   प �¾मीप �¾मी   �श�ा�श�ा   / दा न/ दा न   क र नेक र ने   औ रऔ र   ई सा ईई सा ई   �मशन�र यv�मशन�र यv ,  ,  ®¯®¯   समा �जयvसमा �जयv ,  ,  आ य�आ य�   समा �जयvसमा �जयv
औ रऔ र   मु¿Àममु¿Àम   मौ ल�वयvमौ ल�वयv   क6क6   धमÁ त र णधमÁ त र ण   ग �त �व�धयvग �त �व�धयv   काका   / �त का र/ �त का र   क र नेक र ने   केके   �लए�लए   अमृत सरअमृत सर   म�म�  ' ' �स ंह�स ंह   सभासभा
आंदो लनआंदो लन  ( S ingh S abha M ovement) '   ( S ingh S abha M ovement) '  क6क6   2ा प ना2ा प ना   क बक ब   क6क6   ग ईग ई   थीथी ??

A nsA ns 1. 1873
2. 1851
3. 1865
4. 1929

Q .2 1Q .2 1 य#दय#द  ‘+ ’  ‘+ ’ औ रऔ र  ‘−’  ‘− ’ कोको   प र Çरप र Çर   बद लबद ल   #द या#द या   जा एजा ए   त थात था  ‘× ’  ‘× ’ औ रऔ र  ‘÷ ’  ‘÷ ’ कोको   प र Çरप र Çर   बद लबद ल   #द या#द या   जा एजा ए ,  ,  तोतो
�न��ल	ख त�न��ल	ख त   समी क र णसमी क र ण   म�म�   / Ê/ Ê -- ËचÌËचÌ  ( ? )   ( ? )  केके   2ा न2ा न   प रप र   MाMा   आ एगाआ एगा ??

3 0  ÷  1 0  + 4 0  ×  5 – 3  =?3 0  ÷  1 0  + 4 0  ×  5 – 3  =?
A nsA ns 1. 295

2. 395
3. 205
4. 305

Q .2 2Q .2 2 शdशd  'A BA NDO NA BL E '   'A BA NDO NA BL E '  म�म�   / Qेक/ Qेक   ³र³र   कोको   अं° ेजीअं° ेजी   वण�मा लावण�मा ला   P मP म   म�म�   उ सकेउ सके   बा दबा द   आ नेआ ने   वा लेवा ले   दूस रेदूस रे   अ�रअ�र   सेसे
बद लबद ल   #द या#द या   जा ताजा ता   हैहै   औ रऔ र   / Qेक/ Qेक   3ंजन3ंजन   कोको   अं° ेजीअं° ेजी   वण�मा लावण�मा ला   P मP म   म�म�   उ सकेउ सके   प हलेप हले   आ नेआ ने   वा लेवा ले   ती स रेती स रे   अ�रअ�र   सेसे
बद लबद ल   #द या#द या   जा ताजा ता   हैहै । । �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा   अ�रअ�र   इसइस   / का र/ का र   बनेबने   अ�रअ�र -- समूहसमूह   म�म�   ठÓ कठÓ क   दोदो   बा रबा र
आ एगाआ एगा ??

A nsA ns 1. C
2. K
3. I
4. Q

Q .2 3Q .2 3 70  70  �व!ा �थ�यv�व!ा �थ�यv   क6क6   एकएक   क �ाक �ा   म�म�   क ½ा णक ½ा ण   क6क6   र¢ कर¢ क   शी ष �शी ष �   सेसे  24 24वµवµ   हैहै । । तोतो   नी चेनी चे   सेसे   क ½ा णक ½ा ण   क6क6   र¢ कर¢ क   MाMा   हैहै ??

A nsA ns 1. 
2. 

3. 
4. 

Section : Logical Reasoning
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Q .24Q .24 दीदी   ग ईग ई   ?ृंख ला?ृंख ला   म�म�   / Ê/ Ê -- Ëच�Ëच�  ( ? )   ( ? )  केके   2ा न2ा न   प रप र   MाMा   आ नाआ ना   चा #हएचा #हए ??

1 43  1 43  1 2 8 1 2 8 ?  ?  98 98 83  83  6868
A nsA ns 1. 113

2. 111
3. 119
4. 117

Q .2 5Q .2 5 M  M  काका   िप तािप ता  V   V  हैहै । M  । M  काका   भा ईभा ई  N  N हैहै । N । N काका   भा ईभा ई  O   O  हैहै । O  । O  क6क6   मा तामा ता  L   L  हैहै । V  । V  काका  L   L  सेसे   MाMा   संबंधसंबंध   हैहै ??
A nsA ns 1. भाई

2. प�त
3. प�त का भाई
4. बहन

Q .2 6Q .2 6 �न��ल	ख त�न��ल	ख त   चा रचा र   शdशd -- युÕvयुÕv   म�म�   सेसे   ती नती न   एकएक   �न�¾त�न�¾त   त रo केत रo के   सेसे   समा नसमा न   ह¢ह¢   औ रऔ र   इसइस   / का र/ का र   एकएक   समूहसमूह   बना तेबना ते   ह¢ह¢ ।।
कौ नकौ न -- सासा   शdशd -- युÕयुÕ   उ सउ स   समूहसमूह   सेसे   संबं�धतसंबं�धत   नहµनहµ   हैहै ??
(( नो टनो ट :  :  शdvशdv   कोको   सा थ�कसा थ�क   #हंदी#हंदी   शdvशdv   केके   × प× प   म�म�   मा नामा ना   जा नाजा ना   चा #हएचा #हए   औ रऔ र   उ ��उ ��   शdशd   म�म�   अ�रvअ�रv  /   /  3ंजनv3ंजनv  /   /  ³रv³रv
क6क6   सं¨ासं¨ा   केके   आ धा रआ धा र   प रप र   समूही कृ तसमूही कृ त   नहµनहµ   िक यािक या   जा नाजा ना   चा #हएचा #हए ))

A nsA ns 1. भे#ड़या-पैक (Wolf-Pack)
2. �ब�ी-हड�  (Cat-Herd)
3. मछली-·ूल (Fish-School)
4. भेड़-Ûॉक (Sheep-Flock)

Q .2 7Q .2 7 जबजब   द प�णद प�ण   कोको   नी चेनी चे   द शF येद शF ये   ग येग ये   अनुसा रअनुसा र  XY   XY  प रप र   र खार खा   जा ताजा ता   हैहै   तोतो   दीदी   ग ईग ई   आ कृ �तआ कृ �त   केके   सहीसही   द प�णद प�ण   / �त �ब ंब/ �त �ब ंब   काका
चयनचयन   क र�क र� ।।

A nsA ns 1. 
2. 

3. 
4. 
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Q .2 8Q .2 8 �न��ल	ख त�न��ल	ख त   �वक Þv�वक Þv   म�म�   दोदो   शdvशdv   केके   ऐसेऐसे   युÕयुÕ   #द ए#द ए   ग एग ए ,  ,  जोजो   एकएक   �न�¾त�न�¾त   त क�त क�   केके   अनुसा रअनुसा र ,  ,  एकएक -- दूस रेदूस रे   सेसे
संबं�धतसंबं�धत   ह¢ह¢ । । चा रचा र   शdशd   युÕvयुÕv   म�म�   सेसे   ती नती न   एकएक   समा नसमा न   ह¢ह¢   Mv िकMv िक   उ नकेउ नके   बी चबी च   समा नसमा न   त क�त क�   काका   पा लनपा लन   हुआहुआ   हैहै   औ रऔ र
इसइस   / का र/ का र   वेवे   एकएक   समूहसमूह   बना तेबना ते   ह¢ह¢ । । कौ नकौ न -- सासा   शdशd   युÕयुÕ   उ सउ स   समूहसमूह   सेसे   संबं�धतसंबं�धत   नहµनहµ   हैहै ??

A nsA ns 1. 
2. 
3. 
4. 

Q .2 9Q .2 9 �न��ल	ख त�न��ल	ख त   अ�रअ�र   ?ृंख ला?ृंख ला   काका   संद भ�संद भ�   ल�ल�   औ रऔ र   नी चेनी चे   #द ए#द ए   ग एग ए   / Ê/ Ê   काका   उ ª रउ ª र   द�द� । । �ग नती�ग नती   के वलके वल   बा एंबा एं   सेसे   दा एंदा एं   क6क6
जा नीजा नी   चा #हएचा #हए ।।

(( बा एंबा एं )  C  )  C  X  X  U U W W J  J  O  O  J  J  F  F T  T  U U N N R R E  E  M  M  P P  L  L  F F W W H H Y  Y  M  M  (( दा एंदा एं ))

ऐसेऐसे   िक त नेिक त ने   3ंजन3ंजन   ह¢ह¢   �जनम��जनम�   सेसे   / Qेक/ Qेक   केके   ठÓ कठÓ क   प हलेप हले   एकएक   ³र³र   औ रऔ र   ठÓ कठÓ क   बा दबा द   म�म�   एकएक   3ंजन3ंजन   हैहै ??
A nsA ns 1. तीन

2. पeच
3. चार
4. दो

Q .3 0Q .3 0 एकएक   �न�¾त�न�¾त   त रo केत रo के   सेसे ,  DM  2 7  ,  DM  2 7  काका   संबंधसंबंध  B I  2 2   B I  2 2  सेसे   हैहै । । उ सीउ सी   / का र/ का र ,  UJ  1 3  ,  UJ  1 3  काका   संबंधसंबंध  S F 8   S F 8  सेसे   हैहै । । समा नसमा न
त क�त क�   काका   अनुसर णअनुसर ण   क र तेक र ते   हुएहुए ,  G L  3 7  ,  G L  3 7  काका   संबंधसंबंध   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक ससेिक ससे   हैहै ??

A nsA ns 1. FJ 31
2. EH 32
3. FH 31
4. EI 31

Q .3 1Q .3 1 य#दय#द  ‘+ '   ‘+ '  औ रऔ र  '−'   '− '  कोको   प र Çरप र Çर   बद लबद ल   #द या#द या   जा एजा ए   त थात था  ' × '   ' × '  औ रऔ र  '÷ '   '÷ '  कोको   प र Çरप र Çर   बद लबद ल   #द या#द या   जा एजा ए ,  ,  तोतो
�न��ल	ख त�न��ल	ख त   समी क र णसमी क र ण   म�म�   / Ê/ Ê -- ËचÌËचÌ  ( ? )   ( ? )  केके   2ा न2ा न   प रप र   MाMा   आ एगाआ एगा ??

2 6 ×  2  – 9  + 4  ÷  5 = ?2 6 ×  2  – 9  + 4  ÷  5 = ?
A nsA ns 1. 2

2. 0
3. 21

4. 22
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Q .3 2Q .3 2 दीदी   ग ईग ई   अ�रअ�र   ?ृंख ला?ृंख ला   काका   संद भ�संद भ�   लेले   औ रऔ र   �नम्�नम्नन   / Ê/ Ê   काका   उ ª रउ ª र   द�द� । । �ग नती�ग नती   के वलके वल   बा एंबा एं   सेसे   दा एंदा एं   क6क6   जा नीजा नी   हैहै ।।

(( बा एंबा एं )  )  D  D B  B  A  A  E  X  I  G  E  X  I  G  A  U S  A  U S  P  O  T  P  O  T  R R J  Q  J  Q  A  A  B  S  B  S  V  V  W W (( दा एंदा एं ))

ऐसेऐसे   िक त नेिक त ने   ³र³र   ह¢ह¢   �जनके�जनके   ठÓ कठÓ क   प हलेप हले   एकएक   3ंजन3ंजन   हैहै   औ रऔ र   ठÓ कठÓ क   बा दबा द   म�म�   भीभी   एकएक   3ंजन3ंजन   हैहै ??
A nsA ns 1. चार

2. एक
3. दो
4. तीन

Q .3 3Q .3 3 छहछह   बॉ Wबॉ W  A ,  B,  C ,  D,  E   A ,  B,  C ,  D,  E  औ रऔ र  F  F एकएक   केके   ऊप रऊप र   एकएक   र खेर खे   ग एग ए   ह¢ह¢ ,  ,  लेिक नलेिक न   ज× रoज× रo   नहµनहµ   िकिक   वेवे   इसीइसी   P मP म   म�म�   र खेर खे
ग एग ए   होहो । C  । C  कोको   नी चेनी चे   सेसे   चौ थेचौ थे   2ा न2ा न   प रप र   र खार खा   ग याग या   हैहै । C  । C  औ रऔ र  E   E  केके   बी चबी च   के वलके वल   एकएक   बॉ Wबॉ W   र खार खा   ग याग या   हैहै । D। D
कोको  F  F  केके   ठÓ कठÓ क   नी चेनी चे   र खार खा   ग याग या   हैहै । F  । F सेसे   ठÓ कठÓ क   दोदो   2ा न2ा न   नी चेनी चे  B   B  र खार खा   ग याग या   हैहै । । कौ नकौ न -- सासा   बॉ Wबॉ W , ,  नी चेनी चे   सेसे   दूस रेदूस रे
2ा न2ा न   प रप र   र खार खा   ग याग या   हैहै ??

A nsA ns 1. B

2. D
3. A
4. E

Q .3 4Q .3 4 5 5 एकएक   �न�¾त�न�¾त   त क�त क�   केके   अनुसा रअनुसा र  3 9  3 9 सेसे   संबं�धतसंबं�धत   हैहै । । उ सीउ सी   त क�त क�   केके   अनुसा रअनुसा र  1 6 ,  1 1 6   1 6 ,  1 1 6  सेसे   संबं�धतसंबं�धत   हैहै । । उ सीउ सी   त क�त क�
केके   अनुसा रअनुसा र ,  2 3  ,  2 3  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक ससेिक ससे   संबं�धतसंबं�धत   हैहै ??
(( नो टनो ट :  :  सं¨ा ओंसं¨ा ओं   कोको   उ नकेउ नके   घ ट कघ ट क   अंकvअंकv   म�म�   तो ड़ेतो ड़े   �बना�बना ,  ,  संिP या एंसंिP या एं   प ूण�प ूण�   सं¨ा ओंसं¨ा ओं   प रप र   क6क6   जा नीजा नी   चा #हएचा #हए ।।
उ दा हर णउ दा हर ण   केके   �लए�लए  1 3   1 3  कोको   ली �जएली �जए -  1 3  -  1 3  प रप र   संिP या एंसंिP या एं   जैसेजैसे   िकिक  1 3   1 3  म�म�   जो ड़ नाजो ड़ ना // घ टा नाघ टा ना // गुणागुणा   क र नाक र ना   आ #दआ #द
िक यािक या   जाजा   सक तासक ता   हैहै । 1 3  । 1 3  कोको  1   1  औ रऔ र  3   3  म�म�   तो ड़ नातो ड़ ना   औ रऔ र   िफरिफर  1   1  औ रऔ र  3   3  प रप र   ग ©णती यग ©णती य   संिP या एंसंिP या एं   क र नेक र ने   क6क6
अनुम�तअनुम�त   नहµनहµ   हैहै ।)।)

A nsA ns 1. 165
2. 161
3. 164
4. 163
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Q .3 5Q .3 5 दीदी   ग ईग ई   ãंख लाãंख ला   काका   संद भ�संद भ�   ली �जएली �जए   औ रऔ र   उ सकेउ सके   बा दबा द   #द ए#द ए   ग एग ए   / Ê/ Ê   काका   उ ª रउ ª र   दी �जएदी �जए । । �ग नती�ग नती   के वलके वल   बा एंबा एं   सेसे
दा एंदा एं   क6क6   जा नीजा नी   चा #हएचा #हए । (। ( सभीसभी   सं¨ा एँसं¨ा एँ   के वलके वल   एकएक   अंकअंक   वा लीवा ली   सं¨ा एँसं¨ा एँ   ह¢ह¢ ))
(( बा एँबा एँ )  1  7  8  7  5 8  4  7  1  9  3  1  1  6  8  2  2  8  9  1  8  1  8  1  6  2  2  ()  1  7  8  7  5 8  4  7  1  9  3  1  1  6  8  2  2  8  9  1  8  1  8  1  6  2  2  ( दा एंदा एं ))
ऐसीऐसी   िक त नीिक त नी   समसम   सं¨ा एँसं¨ा एँ   ह¢ह¢ ,  ,  �जनम��जनम�   सेसे   / Qेक/ Qेक   केके   ठÓ कठÓ क   प हलेप हले   एकएक   �वष म�वष म   सं¨ासं¨ा   हैहै   औ रऔ र   ठÓ कठÓ क   बा दबा द   म�म�   एकएक
समसम   सं¨ासं¨ा   हैहै ??

A nsA ns 1. चार
2. दो
3. एक
4. तीन

Q .3 6Q .3 6 नी चेनी चे   सं¨ा ओंसं¨ा ओं   केके   दोदो   समुäयसमुäय   #द ए#द ए   ग एग ए   ह¢ह¢ । । सं¨ा ओंसं¨ा ओं   केके   / Qेक/ Qेक   समुäयसमुäय   म�म� ,  ,  प हलीप हली   सं¨ासं¨ा   प रप र   कु छकु छ   ग ©णती यग ©णती य
संिP या एँसंिP या एँ   क र केक र के   दूसरoदूसरo   सं¨ासं¨ा   /ा å/ा å   हो तीहो ती   हैहै । । इसीइसी   त र हत र ह ,  ,  दूसरoदूसरo   सं¨ासं¨ा   प रप र   कु छकु छ   ग ©णती यग ©णती य   संिP या एँसंिP या एँ   क र केक र के
ती सरoती सरo   सं¨ासं¨ा   /ा å/ा å   हो तीहो ती   हैहै   औ रऔ र   इसीइसी   त र हत र ह   आ गेआ गे   भीभी   हो तीहो ती   ह¢ह¢ । । #द ए#द ए   ग एग ए   �वक Þv�वक Þv   म�म�   सेसे   कौ नकौ न -- सासा   �वक Þ�वक Þ
#द ए#द ए   ग एग ए   समुäयvसमुäयv   केके   समा नसमा न   संिP या ओंसंिP या ओं   काका   अनुसर णअनुसर ण   क र ताक र ता   हैहै ??
(( नो टनो ट :  :  सं¨ा ओंसं¨ा ओं   कोको   उ नकेउ नके   घ ट कघ ट क   अंकvअंकv   म�म�   तो ड़ेतो ड़े   �बना�बना ,  ,  संिP या एँसंिP या एँ   प ूण�प ूण�   सं¨ा ओंसं¨ा ओं   प रप र   क6क6   जा नीजा नी   चा #हएचा #हए ।।
उ दा हर णउ दा हर ण   केके   �लए�लए  1 3  -  1 3   1 3  -  1 3  प रप र   संिP या एँसंिP या एँ ,  ,  जैसेजैसे   िकिक  1 3   1 3  म�म�   जो ड़ नाजो ड़ ना  /   /  घ टा नाघ टा ना  /   /  ग ुणागुणा   क र नाक र ना   आ #दआ #द ,  ,  क6क6   जाजा
सक तीसक ती   ह¢ह¢ । 1 3  । 1 3  कोको  1   1  औ रऔ र  3   3  म�म�   तो ड़ नातो ड़ ना   औ रऔ र   िफरिफर  1   1  औ रऔ र  3   3  प रप र   ग ©णती यग ©णती य   संिP या एँसंिP या एँ   क र नेक र ने   क6क6   अनुम�तअनुम�त   नहµनहµ
हैहै ।)।)

8- 64 - 94 - 1 88;  9- 81 - 1 1 1 -2 2 28- 64 - 94 - 1 88;  9- 81 - 1 1 1 -2 2 2
A nsA ns 1. 7-49-69-138

2. 6-36-66-132
3. 10-100-120-240
4. 5-25-55-120

Q .3 7Q .3 7 दीदी   ग ईग ई   ãंख लाãंख ला   म�म�   / Ê/ Ê -- ËचÌËचÌ  ( ? )   ( ? )  केके   2ा न2ा न   प रप र   MाMा   आ नाआ ना   चा #हएचा #हए ??

1 5/ 3 1 ,  1 9/ 3 9,  2 3/47,  ?  ,  3 1 /63,  3 5/ 711 5/ 3 1 ,  1 9/ 3 9,  2 3/47,  ?  ,  3 1 /63,  3 5/ 71
A nsA ns 1. 27/54

2. 27/55
3. 29/58
4. 29/59
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Q .3 8Q .3 8 उ सउ स   युÕयुÕ   काका   चयनचयन   क6 �जएक6 �जए   जोजो   नी चेनी चे   #द ए#द ए   ग एग ए   दोदो   युÕvयुÕv   केके   समा नसमा न   प ैट न�प ैट न�   काका   अनुसर णअनुसर ण   क र ताक र ता   होहो । । दो नvदो नv   युÕयुÕ
समा नसमा न   प ैट न�प ैट न�   काका   अनुसर णअनुसर ण   क र तेक र ते   ह¢ह¢ ।।

VA R :  RXPVA R :  RXP
KBE  :  G YCKBE  :  G YC

A nsA ns 1. YMR : ULN
2. XLQ : WMO
3. XMP : WNO
4. ZOP : VLN

Q .3 9Q .3 9 उ सउ स   समुäयसमुäय   काका   चयनचयन   क6 �जएक6 �जए   जोजो   नी चेनी चे   #द ए#द ए   ग एग ए   दोदो   समुäयvसमुäयv   केके   समा नसमा न   प ैट न�प ैट न�   काका   अनुसर णअनुसर ण   क र ताक र ता   हैहै ।।
दो नvदो नv   समुäयसमुäय   समा नसमा न   प ैट न�प ैट न�   काका   अनुसर णअनुसर ण   क र तेक र ते   ह¢ह¢ ।।

DF – A C  – XZDF – A C  – XZ
RT – O Q  – L NRT – O Q  – L N

A nsA ns 1. HJ – CF – AC
2. GI – DF – AC
3. GI – DF – CE
4. HJ – CE – DF

Q .4 0Q .4 0 य#दय#द  ‘A’  ‘A’ काका   अथ�अथ�  ‘+ ’  ‘+ ’ हैहै ,  ‘B ’ ,  ‘B ’ काका   अथ�अथ�  ‘− ’  ‘− ’ हैहै ,  ‘C ’ ,  ‘C ’ काका   अथ�अथ�  ‘÷ ’  ‘÷ ’ हैहै   औ रऔ र  ‘D ’  ‘D ’ काका   अथ�अथ�  ‘× ’  ‘× ’ हैहै ,  ,  तोतो   �न��ल	ख त�न��ल	ख त
समी क र णसमी क र ण   म�म�   / Ê/ Ê -- ËचÌËचÌ  ( ? )   ( ? )  केके   2ा न2ा न   प रप र   MाMा   आ एगाआ एगा ??

1 7  D 3  A  2  B  4  C  1  =  ?1 7  D 3  A  2  B  4  C  1  =  ?
A nsA ns 1. 47

2. 49
3. 51
4. 45

Section : General English and Comprehension
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Q .4 1Q .4 1 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
They  ___ their  homework  las t  night .They  ___ their  homework  las t  night .

A nsA ns 1. doing
2. do
3. does
4. did

Q .4 2Q .4 2 S elec t  the mos t appropr iate A NTO NYM  of the given word .S elec t  the mos t appropr iate A NTO NYM  of the given word .

Prec iousPrec ious
A nsA ns 1. Costly

2. Worthless
3. Valuable
4. Treasured

Q .43Q .43 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given groupS elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group
of words .of  words .

A  pers on who s tudies  the weatherA  pers on who s tudies  the weather
A nsA ns 1. Chemist

2. Meteorologist
3. Psychologist
4. Physicist

Q .4 4Q .4 4 Identify  the id iom that  fits  the given s ituat ion.Identify  the id iom that  fits  the given s ituat ion.

M r.  Kanth had to  pay  an exorbitant  amount for  the v intage c ar  that  he bought forM r.  Kanth had to  pay  an exorbitant  amount for  the v intage c ar  that  he bought for
his  eldes t  s on.his  eldes t  s on.

A nsA ns 1. To scrape the barrel
2. To pay through the nose
3. To burn your boats
4. To hit the sack
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Q .4 5Q .4 5 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

You c an’t  enter  the lab ______ y ou are wear ing proper  s afety  gear.You c an’t  enter  the lab ______ y ou are wear ing proper  s afety  gear.
A nsA ns 1. and

2. though
3. or
4. unless
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow. 

Human activities have become the leading cause of biodiversity loss across the
globe. Rapid urbanisation, deforestation, industrial expansion and pollution have
significantly altered natural habitats. Overexploitation of biological resources and
introduction of invasive species further intensify the pressure on native
ecosystems. These causes, driven largely by economic development and
population growth, disrupt the delicate balance of nature.

The effects of biodiversity loss are widespread and deeply concerning.
Ecosystem services such as pollination, water purification and climate regulation
become compromised. The extinction of species affects food chains, leading to
unpredictable ecological consequences. For example, the loss of pollinators
threatens agricultural productivity and food security for millions of people.

Furthermore, biodiversity loss contributes to environmental instability. I t weakens
the resilience of ecosystems, making them more vulnerable to natural disasters
and climate change. As habitats shrink and species disappear, the planet
becomes less capable of supporting life in all its forms, including human life.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 What is  the main idea of the pas s age?What is  the main idea of the pas s age?
A nsA ns 1. The main idea of the passage is to explain the importance of biodiversity

conservation, highlight the causes of biodiversity loss and discuss its effects on
ecosystems and human well-being.

2. The main idea of the passage is to describe the causes of biodiversity conservation,
explain its importance and discuss its effects on agricultural productivity.

3. The main idea of the passage is to explain the role of biodiversity in human
development, discuss its types and explore methods of conservation.

4. The main idea of the passage is to explain the methods of biodiversity conservation,
highlight the types of biodiversity and discuss its effects on ecosystems and human well-
being.
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow. 

Human activities have become the leading cause of biodiversity loss across the
globe. Rapid urbanisation, deforestation, industrial expansion and pollution have
significantly altered natural habitats. Overexploitation of biological resources and
introduction of invasive species further intensify the pressure on native
ecosystems. These causes, driven largely by economic development and
population growth, disrupt the delicate balance of nature.

The effects of biodiversity loss are widespread and deeply concerning.
Ecosystem services such as pollination, water purification and climate regulation
become compromised. The extinction of species affects food chains, leading to
unpredictable ecological consequences. For example, the loss of pollinators
threatens agricultural productivity and food security for millions of people.

Furthermore, biodiversity loss contributes to environmental instability. I t weakens
the resilience of ecosystems, making them more vulnerable to natural disasters
and climate change. As habitats shrink and species disappear, the planet
becomes less capable of supporting life in all its forms, including human life.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 S elec t  the mos t appropr iate A NTO NYM  of the given word from the pas s age.S elec t  the mos t appropr iate A NTO NYM  of the given word from the pas s age.

Protec tedProtec ted
A nsA ns 1. Widespread

2. Vulnerable
3. Critical
4. Severe
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow. 

Human activities have become the leading cause of biodiversity loss across the
globe. Rapid urbanisation, deforestation, industrial expansion and pollution have
significantly altered natural habitats. Overexploitation of biological resources and
introduction of invasive species further intensify the pressure on native
ecosystems. These causes, driven largely by economic development and
population growth, disrupt the delicate balance of nature.

The effects of biodiversity loss are widespread and deeply concerning.
Ecosystem services such as pollination, water purification and climate regulation
become compromised. The extinction of species affects food chains, leading to
unpredictable ecological consequences. For example, the loss of pollinators
threatens agricultural productivity and food security for millions of people.

Furthermore, biodiversity loss contributes to environmental instability. I t weakens
the resilience of ecosystems, making them more vulnerable to natural disasters
and climate change. As habitats shrink and species disappear, the planet
becomes less capable of supporting life in all its forms, including human life.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 S elec t  the mos t appropr iate A NTO NYM  of the given word from the pas s age.S elec t  the mos t appropr iate A NTO NYM  of the given word from the pas s age.

S turdyS turdy
A nsA ns 1. Significant

2. Unsustainable
3. Delicate
4. Rapid
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow. 

Human activities have become the leading cause of biodiversity loss across the
globe. Rapid urbanisation, deforestation, industrial expansion and pollution have
significantly altered natural habitats. Overexploitation of biological resources and
introduction of invasive species further intensify the pressure on native
ecosystems. These causes, driven largely by economic development and
population growth, disrupt the delicate balance of nature.

The effects of biodiversity loss are widespread and deeply concerning.
Ecosystem services such as pollination, water purification and climate regulation
become compromised. The extinction of species affects food chains, leading to
unpredictable ecological consequences. For example, the loss of pollinators
threatens agricultural productivity and food security for millions of people.

Furthermore, biodiversity loss contributes to environmental instability. I t weakens
the resilience of ecosystems, making them more vulnerable to natural disasters
and climate change. As habitats shrink and species disappear, the planet
becomes less capable of supporting life in all its forms, including human life.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 S elec t  the mos t appropr iate t it le for  the given pas s age.S elec t  the mos t appropr iate t it le for  the given pas s age.
A nsA ns 1. Biodiversity and Conservation Methods

2. Protecting Biodiversity for Future Generations
3. Biodiversity and Ecosystem Services
4. Biodiversity in Decline: Human Actions and Their Impact
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow. 

Human activities have become the leading cause of biodiversity loss across the
globe. Rapid urbanisation, deforestation, industrial expansion and pollution have
significantly altered natural habitats. Overexploitation of biological resources and
introduction of invasive species further intensify the pressure on native
ecosystems. These causes, driven largely by economic development and
population growth, disrupt the delicate balance of nature.

The effects of biodiversity loss are widespread and deeply concerning.
Ecosystem services such as pollination, water purification and climate regulation
become compromised. The extinction of species affects food chains, leading to
unpredictable ecological consequences. For example, the loss of pollinators
threatens agricultural productivity and food security for millions of people.

Furthermore, biodiversity loss contributes to environmental instability. I t weakens
the resilience of ecosystems, making them more vulnerable to natural disasters
and climate change. As habitats shrink and species disappear, the planet
becomes less capable of supporting life in all its forms, including human life.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50
Q . 50Q . 50 Identify  the s truc ture of the pas s age.Identify  the s truc ture of the pas s age.
A nsA ns 1. Compare and Contrast

2. Descriptive
3. Cause and Effect
4. Chronological

Q . 51Q . 51 ‘‘ उ ª मउ ª म ’ ’ काका   प यF यवा चीप यF यवा ची   शdशd   हो गाहो गा --
A nsA ns 1. अनुªम

2. ?ेë      
3. शेë       
4. ख़राब              

Section : General Hindi and Comprehension
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Q . 52Q . 52 �न��ल	ख त�न��ल	ख त   �वक Þv�वक Þv   म�म�   सेसे   मुहा वरेमुहा वरे   काका   सहीसही   अथ�अथ�   चुन�चुन� ।।
‘‘ �सर�सर   उ ठा नाउ ठा ना ’’

A nsA ns 1. �सर म� दद�  होना
2. �सर म� खुजली होना
3. �वरोध म� खड़ा होना
4. पागल हो जाना

Q . 53Q . 53 सहीसही   का र कका र क   ËचÌËचÌ   काका   चयनचयन   क रक र   वा Mवा M   कोको   प ूण�प ूण�   क6 �जएक6 �जए ।।
'  '  वहवह   चí दचí द  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . दे ख तादे ख ता   हैहै । '। '

A nsA ns 1. ऊपर
2. के �लए
3. को
4. के Oारा

Q . 54Q . 54 �न��ल	ख त�न��ल	ख त   �वक Þv�वक Þv   म�म�   सेसे   चनाचना   काका   प यF यवा चीप यF यवा ची   शdशd   प हचा न�प हचा न� ।।
A nsA ns 1. आनन

2. पटु
3. र#हला
4. �वधु

Q . 55Q . 55 �न��ल	ख त�न��ल	ख त   �वक Þv�वक Þv   म�म�   सेसे   मुहा वरेमुहा वरे   काका   सहीसही   अथ�अथ�   चुन�चुन� ।।

‘‘ बा तबा त   काका   धनीधनी ’ ’ काका   अथ�अथ�   हैहै ।।
A nsA ns 1. लगातार बात करना

2. wादा बात करना
3. बहुत pानी होना
4. वायदे का प�ा
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C omprehens ion:C omprehens ion:
#दए गए ग!eश के आधार पर �न�eिकत /Êv के उªर दी�जए--
भारतीय राजनी�त म� �े�ीयतावाद के अनेक कारण ह¢, य!िप िकसी भी आधार पर �े�वाद क6 भावना �वक�सत न हो
इसके �लए सं�वधान म� इकहरo नाग�रकता क6 3व2ा क6 गई है । /थम भौगो�लक कारण ह¢, कुछ ऐसे बड़े  राw ह¢
�जनके छोटे-छोटे महîपूण� �े� भौगो�लक ïिr से इकाई बन सकते ह¢ जैसे राज2ान म� मारवाड एवं मेवाड़। #Oतीय
भाषा एवं सं·ृ�त का है �जसके कारण अनेक �े�ीय भावनाएँ जð लेती ह¢। तृतीय आ�थ�क कारण है। महाराrs ,
गुजरात, कनFटक आ#द �वक�सत राw ह¢ जबिक �बहार, पूवñªर के राw, उड़ीसा, उ./ आ#द =ूनतम �वक�सत राw
ह¢। इन राwv के बीच मतभेद उभरना ³ाभा�वक है। चौथा कारण ह¢ जा�त, �जसके कारण �े�ीयतावाद बढ़ा है।
ह�रयाणा और महाराrs  म� �े�ीयता क6 /वृ�ª फैलाने म� जा�त का महîपूण� 2ान रहा है। पíचवí अनेक राजनी�तक
कारणv से भी �े�वाद क6 भावना पनपती है। सòं�धत �े� के राजनी�तpv को यह ³ाथ� #दखने लगता है िक य#द
उस �े� �वशेष को पृथक राw का दजF �मल जाए तो उनक6 राजनी�तक भूख �मट सकती है।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56
Q . 56Q . 56 �न��न�   म�म�   सेसे  ' ' �व�भ­ ता�व�भ­ ता '  '  काका   �वलो म�वलो म   शdशd   हैहै --

A nsA ns 1. �व�वधता
2. समानता
3. पाथ�M
4. एकता
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C omprehens ion:C omprehens ion:
#दए गए ग!eश के आधार पर �न�eिकत /Êv के उªर दी�जए--
भारतीय राजनी�त म� �े�ीयतावाद के अनेक कारण ह¢, य!िप िकसी भी आधार पर �े�वाद क6 भावना �वक�सत न हो
इसके �लए सं�वधान म� इकहरo नाग�रकता क6 3व2ा क6 गई है । /थम भौगो�लक कारण ह¢, कुछ ऐसे बड़े  राw ह¢
�जनके छोटे-छोटे महîपूण� �े� भौगो�लक ïिr से इकाई बन सकते ह¢ जैसे राज2ान म� मारवाड एवं मेवाड़। #Oतीय
भाषा एवं सं·ृ�त का है �जसके कारण अनेक �े�ीय भावनाएँ जð लेती ह¢। तृतीय आ�थ�क कारण है। महाराrs ,
गुजरात, कनFटक आ#द �वक�सत राw ह¢ जबिक �बहार, पूवñªर के राw, उड़ीसा, उ./ आ#द =ूनतम �वक�सत राw
ह¢। इन राwv के बीच मतभेद उभरना ³ाभा�वक है। चौथा कारण ह¢ जा�त, �जसके कारण �े�ीयतावाद बढ़ा है।
ह�रयाणा और महाराrs  म� �े�ीयता क6 /वृ�ª फैलाने म� जा�त का महîपूण� 2ान रहा है। पíचवí अनेक राजनी�तक
कारणv से भी �े�वाद क6 भावना पनपती है। सòं�धत �े� के राजनी�तpv को यह ³ाथ� #दखने लगता है िक य#द
उस �े� �वशेष को पृथक राw का दजF �मल जाए तो उनक6 राजनी�तक भूख �मट सकती है।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 भा र तभा र त   म�म�   �े�ी यता वा द�े�ी यता वा द   काका   का र णका र ण   नहµनहµ   हैहै - -- -
A nsA ns 1. भौगो�लक

2. भाषा एवं सं·ृ�त
3. आ�थ�क
4. धा�म�क
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C omprehens ion:C omprehens ion:
#दए गए ग!eश के आधार पर �न�eिकत /Êv के उªर दी�जए--
भारतीय राजनी�त म� �े�ीयतावाद के अनेक कारण ह¢, य!िप िकसी भी आधार पर �े�वाद क6 भावना �वक�सत न हो
इसके �लए सं�वधान म� इकहरo नाग�रकता क6 3व2ा क6 गई है । /थम भौगो�लक कारण ह¢, कुछ ऐसे बड़े  राw ह¢
�जनके छोटे-छोटे महîपूण� �े� भौगो�लक ïिr से इकाई बन सकते ह¢ जैसे राज2ान म� मारवाड एवं मेवाड़। #Oतीय
भाषा एवं सं·ृ�त का है �जसके कारण अनेक �े�ीय भावनाएँ जð लेती ह¢। तृतीय आ�थ�क कारण है। महाराrs ,
गुजरात, कनFटक आ#द �वक�सत राw ह¢ जबिक �बहार, पूवñªर के राw, उड़ीसा, उ./ आ#द =ूनतम �वक�सत राw
ह¢। इन राwv के बीच मतभेद उभरना ³ाभा�वक है। चौथा कारण ह¢ जा�त, �जसके कारण �े�ीयतावाद बढ़ा है।
ह�रयाणा और महाराrs  म� �े�ीयता क6 /वृ�ª फैलाने म� जा�त का महîपूण� 2ान रहा है। पíचवí अनेक राजनी�तक
कारणv से भी �े�वाद क6 भावना पनपती है। सòं�धत �े� के राजनी�तpv को यह ³ाथ� #दखने लगता है िक य#द
उस �े� �वशेष को पृथक राw का दजF �मल जाए तो उनक6 राजनी�तक भूख �मट सकती है।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 भा र ती यभा र ती य   सं�वधा नसं�वधा न   Oा राOा रा   �े�ी यता वा द�े�ी यता वा द   कोको   रो क नेरो क ने   केके   �लए�लए   3 व2ा3 व2ा   क6क6   ग ईग ई   हैहै - -- -
A nsA ns 1. इकहरo नाग�रकता क6

2. सामा�सक सं·ृ�त क6
3. दोहरo नाग�रकता क6
4. आ�थ�क अनुदानो क6
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C omprehens ion:C omprehens ion:
#दए गए ग!eश के आधार पर �न�eिकत /Êv के उªर दी�जए--
भारतीय राजनी�त म� �े�ीयतावाद के अनेक कारण ह¢, य!िप िकसी भी आधार पर �े�वाद क6 भावना �वक�सत न हो
इसके �लए सं�वधान म� इकहरo नाग�रकता क6 3व2ा क6 गई है । /थम भौगो�लक कारण ह¢, कुछ ऐसे बड़े  राw ह¢
�जनके छोटे-छोटे महîपूण� �े� भौगो�लक ïिr से इकाई बन सकते ह¢ जैसे राज2ान म� मारवाड एवं मेवाड़। #Oतीय
भाषा एवं सं·ृ�त का है �जसके कारण अनेक �े�ीय भावनाएँ जð लेती ह¢। तृतीय आ�थ�क कारण है। महाराrs ,
गुजरात, कनFटक आ#द �वक�सत राw ह¢ जबिक �बहार, पूवñªर के राw, उड़ीसा, उ./ आ#द =ूनतम �वक�सत राw
ह¢। इन राwv के बीच मतभेद उभरना ³ाभा�वक है। चौथा कारण ह¢ जा�त, �जसके कारण �े�ीयतावाद बढ़ा है।
ह�रयाणा और महाराrs  म� �े�ीयता क6 /वृ�ª फैलाने म� जा�त का महîपूण� 2ान रहा है। पíचवí अनेक राजनी�तक
कारणv से भी �े�वाद क6 भावना पनपती है। सòं�धत �े� के राजनी�तpv को यह ³ाथ� #दखने लगता है िक य#द
उस �े� �वशेष को पृथक राw का दजF �मल जाए तो उनक6 राजनी�तक भूख �मट सकती है।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59
Q . 59Q . 59 �न��न�   म�म�   सेसे  ' ' एक ताएक ता '  '  काका   �वलो म�वलो म   शdशd   हैहै --
A nsA ns 1. अखंडता

2. अनेकता
3. समझौता
4. अशe�त
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C omprehens ion:C omprehens ion:
#दए गए ग!eश के आधार पर �न�eिकत /Êv के उªर दी�जए--
भारतीय राजनी�त म� �े�ीयतावाद के अनेक कारण ह¢, य!िप िकसी भी आधार पर �े�वाद क6 भावना �वक�सत न हो
इसके �लए सं�वधान म� इकहरo नाग�रकता क6 3व2ा क6 गई है । /थम भौगो�लक कारण ह¢, कुछ ऐसे बड़े  राw ह¢
�जनके छोटे-छोटे महîपूण� �े� भौगो�लक ïिr से इकाई बन सकते ह¢ जैसे राज2ान म� मारवाड एवं मेवाड़। #Oतीय
भाषा एवं सं·ृ�त का है �जसके कारण अनेक �े�ीय भावनाएँ जð लेती ह¢। तृतीय आ�थ�क कारण है। महाराrs ,
गुजरात, कनFटक आ#द �वक�सत राw ह¢ जबिक �बहार, पूवñªर के राw, उड़ीसा, उ./ आ#द =ूनतम �वक�सत राw
ह¢। इन राwv के बीच मतभेद उभरना ³ाभा�वक है। चौथा कारण ह¢ जा�त, �जसके कारण �े�ीयतावाद बढ़ा है।
ह�रयाणा और महाराrs  म� �े�ीयता क6 /वृ�ª फैलाने म� जा�त का महîपूण� 2ान रहा है। पíचवí अनेक राजनी�तक
कारणv से भी �े�वाद क6 भावना पनपती है। सòं�धत �े� के राजनी�तpv को यह ³ाथ� #दखने लगता है िक य#द
उस �े� �वशेष को पृथक राw का दजF �मल जाए तो उनक6 राजनी�तक भूख �मट सकती है।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 भा र तभा र त   केके   िक निक न   रा wvरा wv   म�म�   जा �तजा �त   केके   आ धा रआ धा र   प रप र   �े�ी यता वा द�े�ी यता वा द   म�म�   बढ़ो ª रoबढ़ो ª रo   हुईहुई   हैहै - -- -
A nsA ns 1. गुजरात एवं कनFटक

2. उ./ एवं �बहार
3. पूवñªर राw
4. ह�रयाणा और महाराrs

Q .61Q .61 उ बंटूउ बंटू  O S  ( Ubuntu O S )   O S  ( Ubuntu O S )  म�म�   �स¹म�स¹म   सेिटंóसेिटंó   केके   हा ड� वेयरहा ड� वेयर   सेô नसेô न   केके   अंत ग�तअंत ग�त   मा उ समा उ स   औ रऔ र   ट चपैडट चपैड   �व ंडो�व ंडो   म�म�
मा उ समा उ स   केके   बा एंबा एं   औ रऔ र   दा एंदा एं   बट नबट न   केके   फ़ंô नफ़ं ô न   कोको   बद लनेबद लने   केके   �लए�लए   िक सिक स   �वक Þ�वक Þ   काका   उ प यो गउ प यो ग   िक यािक या   जा ताजा ता   हैहै ??

A nsA ns 1. माउस कलर (Mouse colour)
2. पॉइंटर Çीड (Pointer speed)
3. /ाइमरo बटन (Primary button)
4. डबल-ö÷क (Double-click)

Section : Basic Knowledge of Computer
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Q .62Q .62 डा य रे ¸डा य रे ¸   बे�निफ टबे�निफट   टs e सफ रटs e सफर  ( DBT)   ( DBT)  केके   �लए�लए   आ धा रआ धा र   कोको   ब¢कब¢क   खा तvखा तv   सेसे   जो ड़ नेजो ड़ ने   काका   /ा थ�मक/ा थ�मक   उ 5ेøउ 5ेø   MाMा   हैहै ??
A nsA ns 1. यह सु�न�¾त करना िक स�ùडी और लाभ सीधे और द�तापूव�क ल��त लाभा�थ�यv तक पहँुच�

2. अंतरFrs ीय धन ह»eतरण को स�म बनाना
3. ऑनलाइन शॉिप ंग के �लए भुगतान क6 सु�वधा /दान करना
4. ऋण आवेदनv के �लए Pेिडट ·ोर /दान करना

Q .63Q .63 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सीसी   ि/ ंिटंगि/ ंिटंग   ग ुणवªागुणवªा ,  ,  ि/ ंट रि/ ंट र   /ो प िट� ज/ो प िट� ज   केके   अंत ग�तअंत ग�त   मौ जूदमौ जूद   नहµनहµ   हो तीहो ती   हैहै ??
A nsA ns 1. टे¸ (Text)

2. लाइü (Lines)
3. ¹¢डड�  (Standard)
4. बॉW (Box)

Q .64Q .64 एमएसएमएस   पॉ वर पॉ इंटपॉ वर पॉ इंट   / ेज�टे शन/ेज�टे शन   कोको   िक सीिक सी   �भ­�भ­   ना मना म   सेसे   सेवसेव   क र नेक र ने   केके   �लए�लए ,  ,  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   �वक Þ�वक Þ
काका   उ प यो गउ प यो ग   िक यािक या   जा ताजा ता   हैहै ??

A nsA ns 1. File > Close
2. File > Save
3. File > Print
4. File > Save As

Q .65Q .65 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा   �वक Þ�वक Þ , ,  इले ş ॉ �नकइले ş ॉ �नक   मेलमेल   भेजनेभेजने   क6क6   / िP या/ िP या   म�म�  S M TP  S M TP /ो टो कॉ ल/ो टो कॉ ल   केके   का य�का य�   काका
सवñ ª मसवñ ª म   वण�नवण�न   क र ताक र ता   हैहै ??

A nsA ns 1. SMTP सव�र पर ईमेल ¹ोर करता है, जब तक िक उ�� /ाåकतF Oारा पुन/Få नहµ िकया जाता है।
2. SMTP /ेषक और /ाåकतF के बीच सुर��त संचार सु�न�¾त करने के �लए ईमेल को एंड-टू-एंड एिþPÿ

करता है।
3. SMTP /ाåकतF को ईमेल को डाउनलोड िकए �बना अपने वेब ®ाउज़र म� पढ़ने क6 सु�वधा देता है।
4. SMTP /ेषक के ईमेल ÷ाइंट से /ाåकतF के ईमेल सव�र तक ईमेल के 2ानeतरण का /ह»न करता है।

Q .66Q .66 Āा ट� फो नĀा ट� फो न   कोको   सुर ��तसुर ��त   र ख नेर ख ने   केके   �लए�लए   हमहम   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा   त रo कात रo का   नहµनहµ   अप ना तेअप ना ते   ह¢ह¢ ??
A nsA ns 1. स्टs ॉग पासवड�  का उपयोग करना

2. मुā Wi-Fi का उपयोग करना
3. फोन अनलॉक करने के �लए पैटन� का उपयोग करना
4. िपन का उपयोग करना
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Q .67Q .67 एड ज¹म�टएड ज¹म�ट   क र नेक र ने   औ रऔ र   डॉ Mूम�टडॉ Mूम�ट   कोको   दे ख नेदे ख ने   केके   �लए�लए ,  ,  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   ऑ Ăनऑ Ăन   काका   उ प यो गउ प यो ग   िक यािक या
जा ताजा ता   हैहै ??

A nsA ns 1. Open
2. Recent
3. Print Preview
4. New

Q .68Q .68 ö÷प बो ड�ö÷प बो ड�   काका   उ प यो गउ प यो ग   क र तेक र ते   समयसमय   मा इPो सॉ ăमा इPो सॉ ă   वड�वड�   म�म�   एकएक   बा रबा र   म�म�   सा मा = तःसा मा = तः   िक त नेिक त ने   आ इट मआ इट म   र खेर खे   जाजा
सक तेसक ते   ह¢ह¢   औ रऔ र   उ ��उ ��   एWेसएWेस   िक यािक या   जाजा   सक तासक ता   हैहै ??

A nsA ns 1. 30
2. 24
3. 26
4. 25

Q .69Q .69 अ�धकe शअ�धकe श   ई मेलई मेल   ÷ा इंट÷ा इंट  (emai l  c l ients)   (emai l  c l ients)  म�म� ,  ,  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा   फ6 चरफ6 चर   यूजरयूजर   कोको   / ेष क/ेष क ,  ,  #द नe क#द नe क
याया   क6 वड�क6 वड�  (s ender,  date,  or  key words)   (s ender,  date,  or  key words)  जैसेजैसे   मा नदं डमा नदं ड   �न#द� r�न#द� r   क र केक र के   बड़ीबड़ी   सं¨ासं¨ा   म�म�   ई मेलई मेल   सेसे   िक सीिक सी
�वशेष�वशेष   ई मेलई मेल   कोको   ती ąताती ąता   सेसे   ढंू ढ नेढंू ढ ने   म�म�   सहा यतासहा यता   क र ताक र ता   हैहै ??

A nsA ns 1. लेबल (Labels)
2. सच� बार (Search Bar)
3. िफ�र (Filters)
4. फो}र (Folders)

Q .70Q .70 M S  M S  वड�वड�   काका  ______  ______ फ़ंô नफ़ंô न , ,  डॉ क्डॉ क् यूम�टयूम�ट   म�म�   सूचीसूची   बना नेबना ने   क6क6   सु�वधासु�वधा   / दा न/ दा न   क र ताक र ता   हैहै ।।
A nsA ns 1. Spell check

2. WordArt
3. Numbering and Bullets
4. Mail Merge

Q .71Q .71 रै नसमवेयररै नसमवेयर  ( rans omware)   ( rans omware)  MाMा   हैहै ??
A nsA ns 1. डेटा का बैकअप लेने का एक तरoका

2. एक /कार का एंटीवायरस सॉćटवेयर
3. एक /कार का मैलवेयर जो उपयोगकतF क6 फ़ाइलv को एिþPÿ करता है और िडिPĂन कंुजी के �लए

भुगतान क6 मeग करता है
4. एक �स¹म अपडेट टूल
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Q .72Q .72 एमएसएमएस   एWेलएWेल   म�म� ,  ,  एकएक   सेलसेल   सेसे   दूस रेदूस रे   सेलसेल   म�म�   फॉ मĈिटंगफॉ मĈिटंग   कोको   शी ĉ ताशी ĉ ता   सेसे   कॉ पीकॉ पी   क र नेक र ने   केके   �लए�लए   िक सिक स   टू लटू ल   काका
उ प यो गउ प यो ग   िक यािक या   जा ताजा ता   हैहै ??

A nsA ns 1. Format Painter
2. Data Validation
3. Conditional Formatting
4. Copy & Paste

Q .73Q .73
A nsA ns 1. 

2. 
3. 
4. 

Q .74Q .74 M S  M S  एWेलएWेल   म�म� ,  ,  ċेड शी टċेड शी ट   केके   सेलसेल   म�म�   िक सीिक सी   टे Čटे Č   याया   सं¨ासं¨ा   / �विr/ �विr   कोको   प ूराप ूरा   क र नेक र ने   सेसे   प हलेप हले   उ सेउ से   र 5र 5   क र नेक र ने   केके
�लए�लए   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   कंु जीकंु जी   काका   उ प यो गउ प यो ग   िक यािक या   जा नाजा ना   चा #हएचा #हए ??

A nsA ns 1. Delete
2. Backspace
3. Enter
4. Esc

Q .75Q .75 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा ,  ,  ईई -- सेवा ओंसेवा ओं   केके   �वत र ण�वत र ण   केके   �लए�लए   ईई -- इंčा ¹s Ďरइंčा ¹s Ďर   / दा न/ दा न   क र नेक र ने   केके   �लए�लए   उ ª र दा यीउ ª र दा यी
हैहै ??

A nsA ns 1. ई-समावेश (e-Inclusion)
2. ई-इंड¹s ी (e-Industry)
3. ई-गवन�म�ट (e-Government)
4. ई-ल�नďग (e-Learning)

Q .76Q .76 M S  PowerPoint  M S  PowerPoint  म�म� ,  ,  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सेसे   ¹ेप¹ेप   प र फॉ म�प र फॉ म�   क र नेक र ने   प रप र   Àा इडÀा इड   शोशो   म�म�   प ूव�प ूव�   �नधF �र त�नधF �र त   समयसमय
केके   बा दबा द   Àा इडÀा इड   ³तः³तः   आ गेआ गे   बढ़े गीबढ़े गी ??

A nsA ns 1. Design -> Set Timings
2. Insert -> Auto Advance
3. Slide Show -> Use Timings
4. View -> Set Timings
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Q .77Q .77 एमएसएमएस   वड�वड�   म�म�  ‘ ‘ डॉ Mूम�टडॉ Mूम�ट   /ॉ प टĐ ज/ॉ प टĐ ज  ( Doc ument Propert ies) ’  ( Doc ument Propert ies) ’ शdशd   काका   MाMा   अथ�अथ�   हैहै ??
A nsA ns 1. डॉMूम�ट के संबंध म� जानकारo, जैसे लेखक, शीष�क और क6वड�

2. ऐसी �वशेषताएँ जो डॉMूम�ट क6 बनावट को प�रभािषत करती ह¢
3. ऐसे फ6चर जो डॉMूम�ट को /ूफ़रoड करने म� सहायता करते ह¢
4. ऐसे फंôन जो डॉMूम�ट फॉमĈिटंग को ³चा�लत करती ह¢

Q .78Q .78 M S  Word M S  Word म�म�  Font S ize  Font S ize डs ॉ पडs ॉ प -- डा उ नडा उ न   मेनूमेनू   म�म�   सूची बKसूची बK   नहµनहµ   िक एिक ए   ग एग ए   क ¹मक ¹म   फ़ॉ Ēफ़ॉ Ē   सा इज़सा इज़   कोको   िP एटिP एट   क र नेक र ने
केके   �लए�लए   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा   चर णचर ण   आ वøकआ वøक   हैहै ??

A nsA ns 1. वeËछत साइज़ तक पहंुचने तक Increase Font Size बटन का उपयोग कर� ।
2. वeËछत फ़ॉĒ साइज़ को सीधे Font Size बॉW म� टाइप कर�  और Enter दबाएं।
3. MS Word म� क¹म फ़ॉĒ साइज़ िPएट नहµ कर सकते।
4. टेČ पर राइट-ö÷क कर�  और कॉĒेČ मेनू से Increase Font Size चुन�।

Q .79Q .79 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा   क6 बो ड�क6 बो ड�   संयो जनसंयो जन ,  M S  ,  M S  वड�वड�   डॉ क्डॉ क् यूम�टयूम�ट   म�म�   सबēĔÿसबēĔÿ   �लख ने�लख ने   केके   �लए�लए   उ प यो गउ प यो ग   िक यािक या
जा ताजा ता   हैहै ??

A nsA ns 1. Ctrl + *
2. Ctrl + _
3. Ctrl + =
4. Ctrl + −

Q .80Q .80 एमएसएमएस -- वड�वड�   /ो से�स ंग/ो से�स ंग   सॉ ăवेयरसॉ ăवेयर   म�म�  'F ind  and Replace'   'F ind and Replace'  फ़6 चरफ़6 चर   काका   उ 5ेøउ 5ेø   MाMा   हैहै ??
A nsA ns 1. Çे�लंग एरर (spelling error) क6 जeच करना

2. डॉMूम�ट क6 कॉपी बनाना
3. िकसी शd या वाMeश (word or phrase) को दूसरे शd या वाMeश से /�त2ािपत करना
4. टेबल को इüट� करना

Q .81Q .81 एकएक   क �ाक �ा   म�म�  1 5  1 5 �व!ा �थ�यv�व!ा �थ�यv   केके   अंकvअंकv   काका   औ सतऔ सत  51   51  हैहै । । य #दय#द   / Qेक/ Qेक   �व!ा थĐ�व!ा थĐ   केके   अंकअंक   दो गुनेदो गुने   क रक र   #द ए#द ए   जा एंजा एं ,,
तोतो   नयानया   औ सतऔ सत   pा तpा त   क6 �जएक6 �जए ।।

A nsA ns 1. 30
2. 15
3. 102
4. 51

Section : Quantitative Aptitude
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Q .82Q .82 एकएक   मो ट रमो ट र   का रका र  60  km/ h  60  km/ h क6क6   चा लचा ल   सेसे   चलनाचलना   शु×शु×   क र तीक र ती   हैहै   औ रऔ र   हरहर   दोदो   घ ंटेघ ंटे   बा दबा द   उ सक6उ सक6   चा लचा ल  1 5 km/ h 1 5 km/ h
बढ़ाबढ़ा   दीदी   जा तीजा ती   हैहै । 3 60  km । 3 60  km क6क6   दूरoदूरo   त यत य   क र नेक र ने   म�म�   उ सेउ से   िक त नािक त ना   समयसमय   लगेगालगेगा ??

A nsA ns 1. 7 घंटे
2. 5 घंटे
3. 2 घंटे
4. 9 घंटे

Q .83Q .83 एकएक   �वPे ता�वPे ता  50   50  प ेनप ेन   बेचक रबेचक र  60   60  प ेनप ेन   क6क6   ला ग तला ग त   वसूलवसूल   क रक र   लेतालेता   हैहै । । उ सकाउ सका   ला भला भ   / �त शत/ �त शत   pा तpा त   क6 �जएक6 �जए ।।
A nsA ns 1. 20%

2. 25%
3. 50%
4. 10%

Q .84Q .84 एकएक   नलनल   िक सीिक सी   ट¢ कट¢ क   कोको   भर नेभर ने   म�म�  1 8   1 8  �मनट�मनट   काका   समयसमय   लेतालेता   हैहै ,  ,  जबिकजबिक   दूसरादूसरा   नलनल   उ सीउ सी   ट¢ कट¢ क   कोको   खा लीखा ली   क र नेक र ने
म�म�  4 0   4 0  �मनट�मनट   काका   समयसमय   लेतालेता   हैहै । । य #दय#द   दो नvदो नv   नलनल   एकएक   सा थसा थ   खो लेखो ले   जा एंजा एं ,  ,  तोतो   ट¢ कट¢ क   कोको   भर नेभर ने   म�म�   िक त नािक त ना   समयसमय
(( �मनटv�मनटv   म�म� )  )  लगेगालगेगा ??

A nsA ns 1. 
           

2 . 
           

3. 
            

4. 
           

Q .85Q .85 एकएक   3 ��3 ��  ₹60 0   ₹60 0  म�म�   एकएक   मो बा इलमो बा इल   फो नफो न   बेचताबेचता   हैहै ,  ,  �जससे�जससे   उ सेउ से   कु छकु छ   धनधन   क6क6   हा �नहा �न   हो तीहो ती   हैहै । । य #दय#द   उ सनेउ सने   इसेइसे
₹1 1 2 0  ₹1 1 2 0  म�म�   बेचाबेचा   हो ताहो ता ,  ,  तोतो   उ सकाउ सका   ला भला भ   उ सेउ से   प हलेप हले   हो नेहो ने   वा लीवा ली   हा �नहा �न   काका  4   4  गुनागुना   हो ताहो ता । । मो बा इलमो बा इल   फो नफो न   काका   P यP य
मू½मू½  ( ₹   ( ₹  म�म� )  )  pा तpा त   क6 �जएक6 �जए ।।

A nsA ns 1. 704
2. 724
3. 684
4. 734
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Q .86Q .86 नी चेनी चे   #द ए#द ए   ग एग ए   3ंजक3ंजक   कोको   सर लसर ल   क6 �जएक6 �जए ।।

A nsA ns 1. 

           
2 . 

           
3. 

            
4. 

Q .87Q .87 एकएक   3ा पा रo3ा पा रo   नेने   सेलसेल   केके   समयसमय   रे डी मेडरे डी मेड   क प ड़vक प ड़v   क6क6   क6 मतvक6 मतv   प रप र  4 0 %  4 0 % क6क6   छूटछूट   क6क6   घो ष णाघो ष णा   क6क6   हैहै । । य #दय#द   िक सीिक सी
°ा हक°ा हक   कोको  ₹1 2 ,80 0   ₹1 2 ,80 0  क6क6   छूटछूट   चा #हएचा #हए ,  ,  तोतो   उ सेउ से  ₹6 ,4 0 0   ₹6 ,4 0 0  क6क6   क6 मतक6 मत   वा लीवा ली   िक त नीिक त नी   शटĘशटĘ   ख रo द नीख रo द नी   चा #हएचा #हए ??

A nsA ns 1. चार
2. दो
3. पeच
4. तीन

Q .88Q .88 A fter  three s ucces s ive equal  percentage hikes  in s alary ,  a  s um of ₹3 0 ,0 0 0  turnedA fter  three s ucces s ive equal  percentage hikes  in s alary ,  a  s um of ₹3 0 ,0 0 0  turned
into ₹3 6 ,751 .2 9 .  F ind the percentage r is e in s alary  at  eac h s tage.into  ₹3 6 ,751 .2 9 .  F ind the percentage r is e in s alary  at  eac h s tage.

A nsA ns 1. 8%
2. 7%
3. 5%
4. 6%

Q .89Q .89 क6 �त �क6 �त �   क6क6   वत�मा नवत�मा न   आ युआ यु   काका  5  5 गुनागुना ,  ,  रा जेशरा जेश   क6क6   वत�मा नवत�मा न   आ युआ यु   केके  7   7  गुनेग ुने   सेसे  1 4   1 4  वष�वष �   अ�धकअ�धक   हैहै ,  ,  त थात था   रा जेशरा जेश   क6क6
वत�मा नवत�मा न   आ युआ यु   काका  8   8  गुनागुना ,  ,  क6 �त �क6 �त �   क6क6   वत�मा नवत�मा न   आ युआ यु   केके  5  5 गुनेग ुने   सेसे  1 1   1 1  वष�वष �   क मक म   हैहै । । क6 �त �क6 �त �   औ रऔ र   रा जेशरा जेश   क6क6
वत�मा नवत�मा न   आ युआ यु   काका   यो गयो ग  ( ( वष�वष�   म�म� )  )  pा तpा त   क6 �जएक6 �जए ।।

A nsA ns 1. 5
2. 11
3. 12
4. 10
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Q .90Q .90 पा इपपा इप  P   P  िक सीिक सी   ट¢ कट¢ क   काका     भा गभा ग  2 8  2 8 घंटेघ ंटे   म�म�   भरभर   सक तासक ता   हैहै   औ रऔ र   पा इपपा इप  Q   Q  उ सीउ सी   ट¢ कट¢ क   काका     भा गभा ग  1 6   1 6  घंटेघ ंटे   म�म�   भरभर
सक तासक ता   हैहै । P  । P  औ रऔ र  Q   Q  दो नvदो नv   कोको  2   2  घंटेघ ंटे   त कत क   खुलाखुला   र खार खा   ग याग या ,  ,  िफरिफर   दो नvदो नv   कोको   बंदबंद   क रक र   #द या#द या   ग याग या ।।
उ सकेउ सके   बा दबा द   के वलके वल   पा इपपा इप  R  R कोको   खो लाखो ला   ग याग या   औ रऔ र   उ सनेउ सने   ट¢ कट¢ क   काका   पा नीपा नी  9   9  घंटेघ ंटे   म�म�   खा लीखा ली   क रक र   #द या#द या । । पा इपपा इप  P,  Q P,  Q
औ रऔ र  R  R �मलक र�मलक र   खा लीखा ली   ट¢ कट¢ क   कोको   िक त नेिक त ने   समयसमय   म�म�   भरभर   सक तेसक ते   ह¢ह¢ ??

A nsA ns 1. 39 घंटे
2. 27 घंटे
3. 28 घंटे
4. 34 घंटे

Q .91Q .91 98 98 औ रऔ र  99  99 केके   वग�वग�   केके   बी चबी च   िक त नीिक त नी   /ा कृ त/ा कृ त   सं¨ा एंसं¨ा एं   ह¢ह¢ ??
A nsA ns 1. 158

2. 100
3. 99
4. 196

Q .92Q .92 #द ए#द ए   ग एग ए   3ंजक3ंजक   कोको   सर ली कृ तसर ली कृ त   क6 �जएक6 �जए । । 

A nsA ns 1. 
            
           

2 . 

3. 
             
             
             
            

4. 
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Q .93Q .93 एकएक   बसबस   आ धीआ धी   दूरoदूरo  72  km/ hr   72  km/ hr  क6क6   चा लचा ल   सेसे   त यत य   क र तीक र ती   हैहै   औ रऔ र   शेषशेष   आ धीआ धी   दूरoदूरo  3 6  km/ hr   3 6  km/ hr  क6क6   चा लचा ल   सेसे
त यत य   क र तीक र ती   हैहै ,  ,  तोतो   उ सक6उ सक6   औ सतऔ सत   चा लचा ल   pा तpा त   क6 �जएक6 �जए ।।

A nsA ns 1. 55 km/hr
2. 44 km/hr
3. 48 km/hr

4. 40 km/hr

Q .94Q .94 मा नमा न   ली �जएली �जए   िकिक   रा जरा ज   केके   वेत नवेत न   काका  60 %,  60 %, अ	ख लअ	ख ल   केके   वेत नवेत न   केके     केके  4 0 %  4 0 % केके   बरा बरबरा बर   हैहै । । य #दय#द   अ	ख लअ	ख ल   काका
वेत नवेत न  ₹4 ,80 0   ₹4 ,80 0  हैहै ,  ,  तोतो   रा जरा ज   काका   वेत नवेत न  ( ₹   ( ₹  म�म� )  )  pा तpा त   क6 �जएक6 �जए । । 

A nsA ns 1. ₹1,720
2. ₹1,920
3. ₹1,820
4. ₹1,650

Q .95Q .95 दोदो   उ nी द वा रvउ nी द वा रv   केके   बी चबी च   हुएहुए   चुना वचुना व   म�म� ,  ,  प ंजी कृ तपंजी कृ त   मत दा ता ओंमत दा ता ओं   म�म�   सेसे  90 %  90 % मत दा ता ओंमत दा ता ओं   नेने   वो टवो ट   डा लाडा ला   औ रऔ र   डा लेडा ले
ग एग ए   वो टvवो टv   म�म�   सेसे  2 0 %  2 0 % वो टवो ट   अवैधअवैध   पा एपा ए   ग एग ए । । जी त नेजी त ने   वा लेवा ले   उ nी द वा रउ nी द वा र   कोको   वैधवैध   वो टvवो टv   म�म�   सेसे  75%  75% वो टवो ट   /ा å/ा å   हुएहुए
औ रऔ र   उ सनेउ सने  1 0 71   1 0 71  वो टvवो टv   केके   अंत रअंत र   सेसे   चुना वचुना व   जी ताजी ता । । प ंजी कृ तपंजी कृ त   मत दा ता ओंमत दा ता ओं   क6क6   सं¨ासं¨ा   pा तpा त   क6 �जएक6 �जए ।।

A nsA ns 1. 2974
2. 2973
3. 2975
4. 2977

Q .96Q .96 �न��ल	ख त�न��ल	ख त   काका   मा नमा न   pा तpा त   क6 �जएक6 �जए ::

3 5 − [ 2 5 − { 3 1  − ( 2 2  − 1 1  + 9) } ]3 5 − [ 2 5 − { 3 1  − ( 2 2  − 1 1  + 9) } ]
A nsA ns 1. 21

2. 20
3. 18
4. 24

Q .97Q .97 छहछह   वष�वष �   प हलेप हले ,  K  ,  K  औ रऔ र  P   P  क6क6   आ युआ यु   काका   अनुपा तअनुपा त  5 :  6   5 :  6  थाथा । । चा रचा र   वष �वष �   बा दबा द ,  ,  उ नक6उ नक6   आ युआ यु   काका   अनुपा तअनुपा त  1 0  :  1 1 1 0  :  1 1
हो गाहो गा । P  । P  क6क6   वत�मा नवत�मा न   आ युआ यु  ( ( वष�वष�   म�म� )  )  pा तpा त   क6 �जएक6 �जए ??

A nsA ns 1. 26
2. 16
3. 18
4. 22
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Q .98Q .98 एकएक   दुका नदा रदुका नदा र   एकएक   टी वीटी वी   सेटसेट   केके   अंिक तअंिक त   मू½मू½   प रप र  1 8%  1 8% क6क6   छूटछूट   दे तादे ता   हैहै । । य #दय#द   टी वीटी वी   सेटसेट   काका   �वP य�वP य   मू½मू½
₹3 0 ,1 76 ₹3 0 ,1 76 हैहै ,  ,  तोतो   टी वीटी वी   सेटसेट   काका   अंिक तअंिक त   मू½मू½   pा तpा त   क6 �जएक6 �जए ।।

A nsA ns 1. ₹36,400
2. ₹36,500
3. ₹36,800
4. ₹36,600

Q .99Q .99 पí चपí च   सं¨ा ओंसं¨ा ओं   काका   यो ग फलयो ग फल  655  655 हैहै । । प हलीप हली   दोदो   सं¨ा ओंसं¨ा ओं   काका   औ सतऔ सत  76  76  हैहै   औ रऔ र   ती सरoती सरo   सं¨ासं¨ा  1 1 5  1 1 5 हैहै । । शेषशेष
दोदो   सं¨ा ओंसं¨ा ओं   काका   औ सतऔ सत   pा तpा त   क6 �जएक6 �जए ।।

A nsA ns 1. 191
2. 194
3. 192
4. 195

Q .1 0 0Q .1 0 0 अमलाअमला   काका   वेत नवेत न  ₹2 0 ,0 0 ,0 0 0   ₹2 0 ,0 0 ,0 0 0  / �त/ �त   वष�वष �   थाथा । । वेत नवेत न   बढ़ा क रबढ़ा क र  ₹2 5,0 0 ,0 0 0   ₹2 5,0 0 ,0 0 0  / �त/ �त   वष�वष �   क रक र   #द या#द या   ग याग या ।।
/ �त शत/ �त शत   वृ©Kवृ©K   pा तpा त   क6 �जएक6 �जए ।।

A nsA ns 1. 25%
2. 15%
3. 20%
4. 35%

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

